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Introduction

Manual information

Revision history
Each page of this manual has the document part number and revision letter at the 
bottom of the page. The revision letter identifies the document’s update level. The 
revision history of this document is summarized below.

Manual purpose
This manual provides technical information for service representatives and technical 
personnel for maintaining the equipment.

Intended audience
This manual is intended for service representatives and technical personnel who 
install, configure, maintain, administer, troubleshoot, or repair this equipment.

Ordering manuals
A paper copy of this manual will be provided upon request. Contact your local GE 
representative and request the part number on the first page of the manual.

Safety information

Responsibility of the manufacturer
GE is responsible for the effects of safety, reliability, and performance only if:

Assembly operations, extensions, readjustments, modifications, or repairs are 
carried out by persons authorized by GE.
The electrical installation of the relevant room complies with the requirements of 
the appropriate regulations.
The equipment is used in accordance with the instructions for use.

Intended use
This device is intended for use under the direct supervision of a licensed health care 
practitioner.

This device is not intended for home use.

Federal law restricts this device to be sold by or on the order of a physician.

Revision Comments

A Initial release.
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Contact GE for information before connecting any devices to the equipment that are 
not recommended in this manual.

Parts and accessories used must meet the requirements of the applicable IEC 60601 
series safety standards, and/or the system configuration must meet the requirements 
of the IEC 60601 medical electrical systems standard.

Periodically, and whenever the integrity of the device is in doubt, test all functions.

The use of accessory equipment not complying with the equivalent safety 
requirements of this equipment may lead to a reduced level of safety of the resulting 
system. Consideration relating to the choice shall include:

use of the accessory in the patient vicinity; and
evidence that the safety certification of the accessory has been performed in 
accordance to the appropriate IEC 60601-1 and/or IEC 60601-1-1 harmonized 
national standard.

If the installation of the equipment, in the USA, will use 240V rather than 120V, the 
source must be a center-tapped, 240V, single-phase circuit.

Hazard definitions
Warnings and Cautions are used throughout this manual and designate a degree or 
level of hazardous situations. A hazard is defined as a source of potential injury to a 
person.

DANGER
DANGER— indicates an imminent hazard which, if not avoided, 
will result in death or serious injury.

WARNING
WARNING— indicates a potential hazard or unsafe practice which, 
if not avoided, could result in death or serious injury.

CAUTION
CAUTION— indicates a potential hazard or unsafe practice which, 
if not avoided, could result in minor personal injury or product/
property damage.

NOTE

A NOTE provides application tips or other useful information.
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Patient Data Module hazards

WARNING

ACCIDENTAL SPILLS—To avoid electric shock or device 
malfunction liquids must not be allowed to enter the device. If 
liquids have entered a device, take it out of service and have it 
checked by a service technician before it is used again.

Equipment symbols
The following symbols appear on the equipment.

ATTENTION: Consult accompanying documents before using the 
equipment.

Defibrillator-proof type CF equipment; type CF equipment is specifically 
designed for applications where a conductive connection directly to the 
heart is established. The paddles indicate the equipment is defibrillator 
proof.

Defibrillator-proof type BF equipment; type BF equipment is specifically 
designed for applications intentional external and internal application to the 
patient, excluding direct cardiac application. Type BF equipment is type B 
equipment with an F-type isolated (floating) part. The paddles indicate the 
equipment is defibrillator proof.

Medical Equipment
With respect to electric shock, fire and mechanical hazards only in 
accordance with UL 60601-1, CAN/CSA C22.2 NO. 601.1, IEC 60601-1, 
IEC 60601-2-27, IEC 60601-2-30, IEC 60601-2-34, and IEC 60601-2-49.

This symbol indicates that the waste of electrical and electronic equipment 
must not be disposed as unsorted municipal waste and must be collected 
separately. Please contact an authorized representative of the 
manufacturer for information concerning the decommissioning of your 
equipment.

This symbol indicates the date of manufacture of this device. The first four 
digits identify the year and the last two digits identify the month.

4P41

2006-08
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Service information

Service requirements
Refer equipment servicing to GE’s authorized service personnel only.
Any unauthorized attempt to repair equipment under warranty voids that 
warranty.
It is the user’s responsibility to report the need for service to GE Medical 
Systems Information Technologies or to one of their authorized agents.
Failure on the part of the responsible individual, hospital, or institution using this 
equipment to implement a satisfactory maintenance schedule may cause undue 
equipment failure and possible health hazards.
Regular maintenance, irrespective of usage, is essential to ensure that the 
equipment is always functional when required.

Battery

Communication

Power

ePort connection

Zero all
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Equipment Identification
Every GE Medical Systems Information Technologies device has a unique serial 
number for identification. A sample of the information found on a serial number label 
is shown below.

Description

1 Product code1

1Product code for the Patient Data Module is SA3.

2 Year manufactured

3 Fiscal week manufactured

4 Production sequence number

5 Manufacturing site

6 Miscellaneous characteristic

### ## ## #### # #

1 2 3 4 5 6
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Equipment Overview

Overview
The Patient Data Module is a data acquisition device for a GE modular system. It 
provides a connection from the host monitor to the patient, processes the patient data 
signals and stores a limited amount of patient data (24 hours captured at 1 minute 
resolution) for seamless transport.

Front view

404B

1 Expansion cover (expansion mount for future expansion 
modules)

2 Communication icon and indicator

3 Power icon and indicator

4 Power ON/IBP Zero All button

5 Patient cable connectors

6 Defib/Sync (for auxiliary equipment)

21 3

5 6 4
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Rear view

405B

Side view

406A

1 ePort host interface connection

2 Battery door

1

2

1 Expansion cover

2 Docking station

3 Pull tab

1

23
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Controls
The power/zero all key has a dual role as a power on and zero all.

Power on — Turns the data acquisition function ON. Power is derived from a 
battery or patient monitor. When turned on, the function changes to the zero all 
function.
Zero all — Zeros all invasive pressure lines which are open to atmosphere. Each 
pressure can also be zeroed, if desired, with a menu option in the pressure menu.

Indicators

Communication

The following LED condition identifies the communication status with a bedside or 
transport patient monitor.

No light indicates no communication.
Solid amber indicates an application reset.
Solid green indicates communication.
Flashing amber indicates communication failure.
Alternately flashing with the power LED indicates software transfer. 

Power 

The following LED condition identifies the power status.

No light indicates no power applied.
Solid amber indicates software booting up.
Solid green indicates powered by AC-derived mains or battery.
Flashing amber indicates approximately five minutes battery power remaining.
Alternately flashing with the communication LED indicates software transfer. 

Connector
Patient Data Modules connect to a bedside or transport patient monitor using the host 
interface connector. It carries power, communication, and analog output signals to the 
display device.
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Basic components

Battery
The Patient Data Module is designed to operate on battery power when used with a 
transport monitor or whenever AC power is interrupted. A complete battery 
management system allows you to obtain maximum battery performance. When 
connected to a bedside monitor, audible and visual alarms alert you when loss of 
power is imminent, and on-screen capacity gauges on the transport monitor indicate 
battery charge condition and capacity.

Patient Data Module ePort host interface cable
The Patient Data Module ePort host interface cable provides external power and 
communication between the Patient Data Module and a patient or transport monitor.

Docking stations
There are three versions of docking stations:

Bedside dock for use with Solar 8000M/i patient monitor.
Transport dock for use with Transport Pro patient monitor. 
Fixed mount adapter (mini dock) for use with mounting hardware.

Patient Data Module bedside dock

The Patient Data Module bedside dock is used for mounting the Patient Data Module 
to a bedside patient monitor. It has a host interface connection which delivers power, 
provides communication and allows easy connection with a patient monitor.

Patient Data Module transport dock

The Patient Data Module transport dock is attached to a transport patient monitor 
when it ships from the factory. It is fastened to the back of the transport patient 
monitor and delivers power, provides communication and allows easy connection and 
disconnection.

Patient Data Module fixed mount adapter (mini dock)

The Patient Data Module fixed mount adapter provides a mechanical connection 
between the Patient Data Module and mounting hardware. There are no electrical 
connections on the mini dock.
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Views

Patient Data Module bedside dock.

480A

Patient Data Module fixed mount adapter (mini dock).

481A
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Theory of operation

Overview
The Patient Data Module is a portable acquisition device. It collects data from a 
patient, converts the data to a digital form for processing, and sends the data to a 
bedside, transport or surgical monitor for further processing and display.

The data that it collects, converts, and sends includes the patient’s vital signs and 
physiological waveforms. It also stores patient history including trends and special 
events, and setup information such as blood pressure zero points and alarm limit 
settings. The patient history is stored so that the collected information is transferred 
when a patient is transferred to a different monitor.

413B

The Patient Data Module shares power and communicates with host devices through 
the host interface connection called the ePort. The Patient Data Module connects 
directly to a transport patient monitor through a docking station. The Patient Data 
Module connects to a bedside host patient monitor through the host interface cable 
and docking station.

The Patient Data Module contains software and hardware to monitor the following 
parameters:

ECG/respiration
Noninvasive blood pressure
Pulse oximetry
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Up to four channels of invasive blood pressure and cardiac output or two 
channels of temperature. 
Defibrillator sync/analog out interface
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3 Installation
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Battery

Test the battery charge
Before installing a battery, verify the battery’s state of charge. Press the green TEST 
button on the battery. The number of charge level indicator LEDs that illuminate 
measures the approximate charge remaining in the battery.

Four LEDs illuminated: 75% – 100% of full charge capacity.
Three LEDs illuminated: 50% – 74.9% of full charge capacity.
Two LEDs illuminated: 25% – 49.9% of full charge capacity.
One LED illuminated: 10% – 24.9% of full charge capacity.
One LED flashing: < 10% of full charge capacity remaining. 

Install or change the battery
1. Open the battery door by gently pulling on the battery door pull tab.

862A

2. Pull the battery tray out of the Patient Data Module using the battery tray strap 
and remove the battery.

3. Insert the new battery with the test button facing up and the arrow pointing into 
the Patient Data Module.

855A
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4. Press the battery door closed until it seals the battery compartment.

WARNING
PHYSICAL INJURY—Make sure the battery is completely inserted 
and that the battery door is securely sealed.

Falling batteries could seriously or fatally injure neonatal or other 
vulnerable patients.

5. Press the Power button on the Patient Data Module.

6. Verify that the Power indicator illuminates amber while the Patient Data Module 
boots up, then illuminates green.

Software
The Patient Data Module leaves the factory with software installed. If you need to 
install the software, contact your GE representative. 

Mounting options

WARNING
For safety reasons, all connectors for patient cables and sensor leads 
are designed to prevent inadvertent disconnection, should someone 
pull on the leads. Do not route cables in a way that they may present 
a stumbling hazard.

WARNING
PHYSICAL INJURY—Do not hang articles on the IV pole that are 
not related to the Patient Data Module’s use.

Do not place the Patient Data Module more than 147 cm (58 in) 
from the floor when mounting on an IV pole with a base not less 
than 58 cm (23 in) in diameter.

WARNING
To reduce the ingress of water into the equipment, do not mount the 
Patient Data Module in a vertical position with the patient cables 
facing up or down.
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Mounting options include mounting to a bed headboard or footboard, an IV pole, or a 
roll stand using one of the docking stations. Mounting kits include all necessary 
hardware and installation instructions.

483A
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Connect to host patient monitor

Connect to transport bedside monitor
If using the Patient Data Module with a transport bedside monitor,

1. Guide the mounting rails of the Patient Data Module onto the transport dock 
mounting rails. 

2. Slide the Patient Data Module toward the ePort until the locking key secures it to 
the transport dock.

Connect to bedside monitor
If using the Patient Data Module with a bedside monitor, 

1. Connect one end of the ePort host interface cable to the Patient Data Module 
ePort connector.

2. Connect the other end of the ePort host interface cable to the Solar to Patient 
Data Module adapter on the back of the Solar 8000M/i patient monitor.
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4 Service Tool and 
Configuration
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Overview
The Patient Data Module service tool provides the following:

Device information 
Configuration including asset setting, ECG filter configuration, licensing and 
software transfer
Diagnostics
Calibration

All service functions for the Patient Data Module are performed through a service 
laptop.

Required equipment
The following is a list of equipment to use with the GEHC MS service tool.

If servicing the Patient Data Module using a Solar 8000M/I patient monitor:

PC with Microsoft® Windows® XP or 2000™ operating system, a CD-ROM 
drive, and a network card
Category 5 crossover cable (2028822-001)
ePort to host interface cable (2017098-002)
Solar 8000M/i patient monitor with PDM service adapter (2028845-002)
Patient Data Module software CD with GEHC MS Service Tool

If servicing the Patient Data Module without a host patient monitor:

PDM Service Tool Kit (2030924-001)

Set up the PC

Connect the PC to the Patient Data Module
There are two ways to connect the PC to the Patient Data Module. One method uses 
power from the Solar 8000M/i patient monitor, the other method uses an external 
power supply. 
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Power from Solar 8000M/i patient monitor

431A

Power from external power supply

1. Connect the category 5 crossover cable between the PC network port and the 
PDM service adapter.

2. Connect the ePort to host interface cable between the ePort on the Patient Data 
Module and the ePort connector on the PDM service adapter.

3. If the PDM service adapter is not connected to a Solar 8000M/i patient monitor, 
connect the external power supply to the PDM service adapter.

4. Remove the Patient Data Module battery.

5. Press the power button on the Patient Data Module.

6. Power on the PC.

ePort to host cablecrossover cable

ePort to host cablecrossover cable

external power supply
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Change the PC’s IP address
NOTE

Disable all network ports on the PC except the Patient Data Module connection.

Disable firewall and networking services
If your PC is running any firewall protection or networking services, such as Cisco 
Systems VPN, BlackICE, Security Accounts Manager or a wireless network card, 
perform the following procedure to disable these services on the PC.

1. Select one of the following from the toolbar:

In Windows XP, select Start > Control Panel > Administrative Tools > 
Services.
In Windows 2000, select Start > Settings > Control Panel > Administrative 
Tools > Services.

2. In the list of available firewall and networking services, double-click the service 
(e.g. Black ICE and Security Accounts Manager) to be disabled.

Windows XP Windows 2000

1. From the toolbar, select Start > Run

2. Type cmd and press Enter.

3. Type ipconfig<space>/all and press Enter.

4. If the IP address and subnet mask are defined, record them:

IP address: _______________________________________
Subnet mask: _________________________________________

5. From the toolbar, select Start > 
Control Panel > Network 
Connections.

From the toolbar, select Start > Settings > Control Panel > 
Network and Dial-up Connections.

6. Right-click Local Area Connection.

7. Select Properties.

8. Select Internet protocol (TCP/IP).

9. Click Properties.

10. Select Use the following IP address.

11. In the IP address field, type 192.168.252.95. 

12 In the Subnet mask field, type 255.255.255.0

13. If prompted to restart the PC, select Yes.

18. Continue with the instructions, Disable firewall and networking services on page 4-4.
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3. In the specific service (e.g. BlackICE and Security Accounts Manager) properties 
window, select Stop.

456A

4. Verify that the Service status reads Stopped.

Click Stop
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5. To disable the Security Accounts Manager, select Disable from the Startup type 
drop down list.

6. Select Apply to disable the Security Accounts Manager.

7. Select Ok and close all windows.

8. Repeat these steps for all VPN, wireless network cards or any firewall protection 
programs running on your PC.

NOTE

If you are unsure of the firewall and networking services on your PC, contact 
your local IT administrator for details. Windows 2000 and XP PC’s allow 
you to send a list of services to your IT administrator.

Enter the Patient Data Module service tool
1. Properly connect and configure the Patient Data Module and service laptop as 

described in Set up the PC on page 4-2.

2. Insert the Patient Data Module software CD in the CD-ROM drive. The GEHC 
MS Tool application opens automatically.

If the GEHC MS Tool application does not launch, open the CD-ROM drive and 
double-click ShellExecute.js.

3. Type the username and password and click login or press Enter on the keyboard.

Username: biomed

Password: ChangeMe

Verify 
Stopped
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NOTE

Username and password are case sensitive.

Username and password cannot be created, edited or deleted.

433A

Service tool modules
The GEHC MS Service Tool has four categories; Device Information, 
Configuration, Diagnostics, and Calibration. Each category contains module(s) for 
servicing the Patient Data Module. Click on the category tab, then the module. The 
following is a brief overview of these modules.

NOTE

Some information displayed in the module, only updates in 30 second intervals.

The GEHC MS Service Tool provides a basic description of each module in the 
Help file. From the toolbar in the module, click Help > Help. 

Device Information
The Device Information module displays general information about the Patient Data 
Module. and calibration information. It also displays the last date and times that NBP 
calibration, analog-out IP calibration, and analog-out ECG calibration was performed.

NOTE

To print the Device Information page, connect a parallel printer or enable a 
network port that has connectivity to a network printer. Click File > Print. After 
printing, disconnect or disable the network port used for printing to prevent 
inadvertent access to the Patient Data Module.
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Configuration
The Configuration category consists of Asset Settings, ECG Filter Config, 
Licensing and Software Transfer modules.

Asset Settings

The Asset Settings module displays the manufacturer’s serial number and the user 
assigned asset number. 

1. Enter the serial number and click Submit.

NOTE

The manufacturer’s serial number must follow the specific format found on 
the serial number label on the Patient Data Module.

The manufacturer’s serial number must be edited if the main cpu board is 
replaced.

464A

2. Enter the user assigned asset number and click Submit.

NOTE

The user assigned asset number can be up to 13 alphanumeric characters.

serial number
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ECG Filter Config

The ECG Filter Config module allows configuration of the power frequency and 
ECG filter.

The power frequency of the Patient Data Module must match the power frequency of 
the host patient monitor.

The ECG filter is always enabled. It can be disabled temporarily, but it will always 
default to Enabled after a power cycle or reboot.

CAUTION
Do not disable ECG Filter during clinical use.

Licensing

The Licensing module is used for activating or removing license(s). To obtain a 
license, contact GE technical support and provide the Patient Data Module serial 
number and MAC address. See the “How to Reach Us...” page included with this 
manual for contact information.

Enter the activation code and click Activate to complete the installation. Click 
Remove to remove a license.

NOTE

After installation, perform the checkout procedures provided in the host patient 
monitor service manual.

A new activation code must be requested and entered if the main cpu board is 
replaced.

Software Transfer

The Software Transfer module is used for installing Patient Data Module software. 
Follow the instructions displayed on the screen.

To power cycle the Patient Data Module, disconnect and reconnect the ePort host 
interface connector.

CAUTION
Do not disconnect the power during software transfer. The Patient 
Data Module could be damaged.

NOTE

After installation, perform the checkout procedures provided in the host patient 
monitor service manual.
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Diagnostics
The Diagnostics category consists of Log Files and Service Metrics modules.

Log Files

The Log Files module allows viewing and downloading log files. Messages and 
errors in log files provide useful information to a trained technician.

 Click View Log to view or Download Log to download the log file.

Service Metrics

The Service Metrics module displays various Patient Data Module statistics. NBP 
STATISTICS can be useful in determining NBP usage.

Click REFRESH ALL to refresh the data.

The following buttons clear NBP data:

NBP Pump Run time 
NBP Deflate Valve Cycle Count 
NBP Dump Valve Cycle Count
NBP Pump Cycle Count

NOTE

Some Patient Data Module statistics only update every 30 seconds.

After replacing the NBP pump assembly, clear all NBP statistics and perform the 
checkout procedures provided in the host patient monitor service manual.

If a value in the Service Metrics module is out of specification, the data field will 
be highlighted red. Contact GE technical support. See the “How to Reach Us...” 
page included with this manual for contact information.

Calibration
The Calibration category consists of Analog-Out ECG Calibration and Analog-Out 
IP Calibration. The following additional equipment in required to perform this 
calibration:

Unterminated defib sync cable (2017842-001, part of the Patient Data Module 
Service Tool Kit)
Digital voltmeter

1. Connect the unterminated cable to the Defib/ Sync connector on the front of the 
Patient Data Module.

2. Click Start Calibration to begin the calibration process.

3. Follow instructions displayed on screen.

NOTE

To abort the calibration process with no changes, press Stop Calibration.
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4. Measure voltages indicated below using the digital voltmeter.

435A

To calibrate Analog-Out ECG, measure voltage across the following pins.

To calibrate Analog-Out IP, measure voltage across the following pins.

5. Type in or use the scroll buttons to enter the measured voltage from the digital 
voltmeter.

6. Click OK to confirm the measured voltage.

NOTE

Perform calibration if the main cpu board is replaced.

After calibration perform the checkout procedures provided in the host 
patient monitor service manual.

Pin Wire color Signal name

1 Brown ECG_ANALOG_OUT

6 Green ANALOG_RETURN

Pin Wire color Signal name

2 Red BP_ANALOG_OUT

6 Green ANALOG_RETURN
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Maintenance schedule

Manufacturer recommendations
To help ensure the equipment remains in proper operational and functional order, 
adhere to a good maintenance schedule. The manufacturer recommends that the 
following be performed by service personnel upon receipt of the equipment, every 12 
months thereafter, and every time the unit is serviced:

Visual inspection
Cleaning
Battery maintenance
Electrical safety tests (See the Solar 8000M/i patient monitor v5 service manual, 
Maintenance and checkout chapter for system tests.)
Checkout procedures (See the Solar 8000M/i patient monitor v5 service manual, 
Maintenance and checkout chapter for system tests.)

Manufacturer responsibility

WARNING
Failure on the part of all responsible individuals, hospitals or 
institutions, employing the use of this device, to implement the 
recommended maintenance schedule may cause equipment failure 
and possible health hazards. The manufacturer does not, in any 
manner, assume the responsibility for performing the recommended 
maintenance schedule, unless an Equipment Maintenance 
Agreement exists. The sole responsibility rests with the individuals, 
hospitals, or institutions utilizing the device.

Inspection
Remove power and all cables before inspecting or cleaning the equipment. 

Inspect the equipment and its components carefully prior to installation, once every 
12 months thereafter and each time the equipment is serviced. Do not use the 
equipment if damage is determined. Refer damaged equipment to qualified service 
personnel.

Inspect the case for cracks or other physical damage. 
Inspect cables for fraying or other damage. 
Inspect all plugs and connectors for bent pins or other damage.
Check for loose or missing screws on the mounting hardware.

NOTE

 Damaged cables or equipment should be replaced by service personnel.
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Cleaning

Precautions
Improper cleaning methods can result in degradation of the equipment performance 
and/or failure. To avoid damage to the equipment:

Never use conductive solutions, solutions that contain chlorides, wax, or wax 
compounds to clean the equipment.
Never immerse equipment in any liquid.
Never pour or spray any liquid on the equipment or permit fluid to seep into 
connections or openings.
Never autoclave or steam clean the equipment.
Never use the following solutions; acetone, Bentadine, ketone, alcohol-based 
cleaners, sodium salts, abrasive cleaners or any type of Ammonium Chloride 
such as Dimethyl Benzyl Ammonium Chloride or Quaternary Ammonium 
Chloride.
Never connect the device to a patient until it is thoroughly dry.

Cleaning procedures

CAUTION
Failure to follow these rules may melt, distort, or dull the finish of 
the case, blur lettering on the labels, or cause equipment failures. 

1. Remove power, all cables and batteries. 

2. Close the battery door.

3. Wipe the exterior with a soft, lint-free cloth using one of the following solutions 
recommended in the APIC Guidelines for Selection and Use of Disinfectants 
(1996):

Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution 
(minimum 100 ppm free chlorine) and maximum 1:10 dilution.
Any sodium hypochlorite wipe product that meets the above guidelines.

NOTE

Wring excess disinfectant from cloth before using.

Contact of disinfectant solutions with metal parts may cause corrosion.

Do not damage or bend connector pins when cleaning or drying.

4. Allow solution to remain on device for a minimum of one minute or per hospital 
guidelines.

5. Do not let fluid “pool” around connection pins. If this happens, blot dry with a 
cotton swab or soft cloth. Shake out excess liquids from connector recesses.

6. Wipe off cleaning solution with a clean, moist cloth.
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7. Dry thoroughly with a clean, dry, lint-free cloth and let air dry for at least 30 
minutes. Do not apply heat.

NOTE

Drying times may vary based on the environmental conditions.

Storage
Remove batteries when the device is not in use, even for short periods of time.
Store in a dry well-ventilated area.
Hang the device using a holder if available.
If leadwires or cables are attached, hang them straight.
Do not coil leadwires or cables tightly around the device.

Consequences of using improper cleaning product
Appearance of waveforms when the device is not connected to a patient, causing 
false alarms instead of a leads fail alarm and possibly not providing a visual or 
audible leads fail alarm.
Brittle and breaking device case.
Overall system performance degradation.
Melting, dulling, or distorting the case.
Total medical device failure requiring replacement.
Unit malfunction.
Void warranty.

Cleaning products to avoid
Cleaning products known to cause the types of problems listed above include, but are 
not limited to:

Sani-Cloth® Wipes
Ascepti® Wipes
HB Quat®

Clorox® Wipes (they do not contain bleach)
Over-the-counter detergents (e.g. Fantastic®, Tilex®, etc.).

Products that contain active ingredients and solutions similar to these products should 
also be avoided.

NOTE

For additional information, refer to the How the Reach Us page in the manual for 
contact information.



Maintenance

2030047-001A Patient Data Module 5-5

Expansion interface cleaning
Under normal operation, the expansion interface should not require cleaning. If the 
expansion interface does require cleaning, follow these instructions.

CAUTION
The expansion interface is not waterproof.
Do not let fluids enter the electronics through the expansion 
interface.
Do not spray fluid into the expansion interface.
Cleaning the expansion interface in a manner other than that 
specified below may cause the unit to malfunction and void the 
warranty.

1. Use a cellular urethane cleaning swab lightly moistened with one of the 
following solutions recommended in the APIC Guidelines for Selection and Use 
of Disinfectants (1996):

Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution 
(minimum 100 ppm free chlorine) and maximum 1:10 dilution.
Any sodium hypochlorite wipe product that meets the above guidelines.

NOTE

Wring excess disinfectant from cloth before using.

Contact of disinfectant solutions with metal parts may cause corrosion.

Do not damage or bend connector pins when cleaning or drying.

2. Insert the swab under the expansion interface to clean.

484A

NOTE

Avoid inserting the swab toward the rear of the expansion interface where 
connector pins can be damaged.

3. Do not let fluid “pool” around connection pins. If this happens, blot dry with a 
cotton swab or soft cloth. Shake out excess liquids from connector recesses.
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4. Wipe off cleaning solution with a clean, moist swab.

5. Dry thoroughly with a clean, dry, swab and let air dry for at least 30 minutes. Do 
not apply heat.

NOTE

Drying times may vary based on the environmental conditions.

Battery compartment cleaning
Under normal operation, the battery compartment should not require cleaning. If the 
battery compartment does require cleaning, follow these instructions.

CAUTION
The battery compartment is not waterproof.
Do not let fluids enter the electronics through the air holes in the 
battery compartment floor.
Cleaning the battery compartment in a manner other than that 
specified below may cause the unit to malfunction and void the 
warranty.

1. Remove the battery from the battery compartment.

2. Clean the device with a gauze pad or cloth lightly moistened with one of the 
following:

Water
Soap

3. Use a cloth lightly moistened with distilled water to rinse away the cleaning 
solution. Make sure moisture does not enter the electronics area below the battery 
compartment floor.

4. Dry thoroughly with a lint-free cloth. Allow the battery compartment to air dry 
completely prior to closing the compartment door.

Sterilization
NOTE

EtO sterilization is not recommended, but may be required for cables and 
leadwires. Frequent sterilization will reduce the useful life of cables and 
leadwires.

Sterilize with ethylene oxide gas (EtO) at a maximum temperature of 50º C (122º F). 
After EtO sterilization, follow the recommendations from the sterilizer manufacturer 
for required aeration.
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Battery care
The Lithium-Ion battery is a rechargeable battery containing Lithium-Ion cells. Each 
battery contains an integrated electronic fuel gauge and a safety protection circuit. 
The processor within the equipment communicates with both the battery and the 
charger.

The following are facts about Lithium-Ion battery technology:

The battery discharges on its own, even when it is not installed in the equipment. 
This discharge is the result of the Lithium-Ion cells and the bias current required 
for the integrated electronics. 
The self-discharge rate doubles for every 10°C (18°F) rise in temperature.
The capacity loss of the battery degrades significantly at higher temperatures.
As the battery ages, the full-charge capacity of the battery degrades and is 
permanently lost. As a result, the amount of charge that is stored and available for 
use is reduced.

The following terms are used to define the battery capacity:

Design capacity — The theoretical capacity of the battery cells when the battery 
is new.
Full charge capacity — The actual amount of charge the battery can store and 
deliver.
Remaining charge capacity — The amount of full charge capacity currently 
remaining in the battery. This is a percent of full charge capacity.

Use recommendations
GE recommends the following methods to improve battery performance:

Location — Position the equipment in a location that does not artificially 
increase the operating temperature of the batteries.
Charging method — Whenever possible, use the Cadex SMart Two+ charger to 
charge the battery. The Cadex SMart Two+ charger maintains a lower battery cell 
temperature during the charge cycle. This reduction in temperature can extend 
the life of the battery.
Conditioning guideline — Remove the batteries from the equipment every six 
months and condition it using the Cadex SMart Two+ charger. This condition 
cycle recalibrates the electronic fuel gauge.

Storage recommendations
Store the battery outside of the device at a temperature between 20°C to 25°C (68°F 
to 77°F). Storing the battery inside the Patient Data Module is not recommended for 
the following reasons:

In a device that is powered by an AC power source, the battery cell temperature 
increases by 10°C to 15°C (18°F to 27°F) above the room’s ambient temperature. 
This reduces the life of the battery.
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In a device that is powered by an AC power source (“floating”), the battery self-
discharges to less than 90% of its full charge capacity after approximately two 
weeks. The battery is then recharged to 100% resulting in a 95% average state of 
charge. Storing the battery at a high state of charge also reduces the life of the 
battery. GE recommends that you remove the battery and store it near the Patient 
Data Module until it is needed.

Charge the battery
The battery can be charged by one of two methods:

Inside a Patient Data Module that is connected to a powered host.
Outside the Patient Data Module using a Cadex Smart2+ Battery Charger.

Charge with a Cadex Smart2+ battery charger

1. Insert the battery into the battery charger. The RUN LED lights.

2. Leave the battery in the charger until the READY LED lights

NOTE

If the FAIL LED lights, remove the battery from the battery charger and 
reinsert it. This corrects any battery charger time out errors. If the FAIL 
LED still lights, replace the battery.

Charge inside the Patient Data Module

The battery charges whenever the Patient Data Module is connected to an AC 
powered host.

Condition the battery

Remove or replace the battery

1. Open the battery door at the rear of the Patient Data Module.

2. Remove the battery.

3. Insert a new battery with the connection pins inserted first and facing down.

4. Close the battery door.

5. Connect Patient Data Module to a host patient monitor and confirm that the 
battery LED lights green and the battery icon displays in the lower corner of the 
patient monitor.
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Recycle the battery

Recycle the battery when it no longer holds a charge. Remove the battery from the 
Patient Data Module and follow your local recycling guidelines.

WARNING
EXPLOSION HAZARD—Do not incinerate the battery or store at 
high temperatures. Serious injury or death could result.

In the United States and Canada, the Rechargeable Battery Recycling Corporation 
(RBRC) can help locate your nearest rechargeable battery collection site. Contact 
them by 

telephone: 1-800-8-BATTERY (800-822-8837)
internet: www.rbrc.org

Checkout procedures and NBP calibration
GE recommends that qualified service personnel perform system checkout 
procedures (including electrical safety tests, parameter tests, and NBP calibration) 
found in the Solar 8000M/i patient monitor service manual:

upon receipt of the equipment,
every 12 months thereafter,
any time the equipment is serviced, or
any time the validity of the NBP pressure readings is in doubt.
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6 Troubleshooting
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Overview
The problems and solutions in this chapter represent only a few of the faults that you 
may encounter and are not intended to cover every possible problem that may occur.

Required tools and equipment
The following lists necessary tools for troubleshooting:

Patient Data Module software CD with GEHC MS service tool (shipped with 
Patient Data Module)
Solar 8000M/i patient monitor with PDM service adapter (2028845-002)
PC with Microsoft Windows XP or 2000 operating system, a CDROM drive, and 
a network card
Category 5 crossover cable (2028822-001)
ePort to host interface cable (2017098-002)

If troubleshooting the Patient Data Module without a host patient monitor:

PDM Service Tool Kit (2030924-001)

Before you begin. . .
Before beginning any detailed troubleshooting, complete a thorough visual inspection 
to be sure

All I/O cable connections are secured
All patient devices are properly powered
PC with GEHC MS Service Tool is properly connected to the Patient Data 
Module
See Connect the PC to the Patient Data Module on page 4-2 for details.
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Problems and solutions

Problem Solution

Battery is not charging Check the Patient Data Module’s battery interface as follows.

1. Check for damage to the battery tray. If damaged, replace the battery tray. See chapter 7, Field 
Replaceable Units for ordering parts and replacement procedures.

2. Check for damage to the battery connector inside the battery compartment. If damaged, contact GE 
technical support to service the Patient Data Module. See the “How to Reach Us...” page included with 
this manual for contact information.

3. Check that the battery is charging by inserting a known good battery in the Patient Data Module. If not 
charging, contact GE technical support to service the Patient Data Module. See the “How to Reach 
Us...” page included with this manual for contact information.

Check the Patient Data Module’s battery as follows.

1. Check that the battery is fully charged by pressing the TEST button on the battery. If the LED is not at 
100%, go to Battery care on page 5-7 for further charging and conditioning procedures.

2. Check for damage to the battery connector and external surfaces. If damaged, replace the battery.

3. Check that the battery is charging with the GE approved battery charger. See Battery care on page 5-7 
for procedures. If not charging, replace the battery.

External surface is 
damaged

Check the Patient Data Module’s top housing as follows.

1. Check for cracks or other damage to the top housing. If damaged, replace the top housing. See chapter 
7, Field Replaceable Units for ordering parts and replacement procedures.

2. Check for cracks or other damage to the bottom housing. If damaged, contact GE technical support to 
service the Patient Data Module. See the “How to Reach Us...” page included with this manual for 
contact information.

NBP is not functioning Check the NBP calibration date and time as follows.

1. Use the GEHC MS service tool (See chapter 4, Service Tool and Configuration) and go to the Device 
Information module.

2. If NBP is not calibrated, perform the NBP calibration according to the procedures in the Solar 8000M/i 
service manual, Maintenance and checkout chapter.

Check the NBP performance as follows.

1. Go to the Solar 8000M/i patient monitor service manual Maintenance and checkout chapter and 
perform the NBP calibration check.

2. If NBP pressure is leaking (not maintaining CUFF pressure for at least one minute), check for leakage 
on the NBP cuff. (Listen for hissing as air escapes.)

3. If the cuff is not leaking, use the GEHC MS service tool (See chapter 4, Service Tool and Configuration) 
and go to Diagnostics > Service Metrics (See Diagnostics on page 4-10). Record the NBP statistics 
information for trending.

4. Replace the NBP assembly with manifold. See chapter 7, Field Replaceable Units for ordering parts 
and replacement procedures.
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No power 1. Check for damage to the ePort to host interface cable. If damaged, replace the cable.

2. Check for damage to the Tram-net port on the patient monitor. If damaged, go to the Solar 8000M/i 
patient monitor service manual, Field replaceable units chapter for ordering parts.

3. Connect a known good Patient Data Module to the patient monitor. If the Patient Data Module is not 
powering, go to the Solar 8000M/i patient monitor service manual Troubleshooting chapter for further 
information.

4. Check for damage to the ePort interface on the Patient Data Module. If damaged, contact GE technical 
support to service the Patient Data Module. See the “How to Reach Us...” page included with this 
manual for contact information.

5. Check the Patient Data Module’s battery following steps in the ‘Battery is not charging’ section in this 
table.

No communication 
indicators (LEDs not 
illuminated)

1. At the patient monitor, check the M-Port status LED. If it is not green, go to the Solar 8000M/i patient 
monitor service manual Troubleshooting chapter for further information.

2. Follow steps in the ‘No power’ section in this table. 

No parameters 1. Check for damage to the parameter cable(s). If damaged, replace cables.

2. Check for damage to the parameter interface. If damaged, contact GE technical support to service the 
Patient Data Module. See the “How to Reach Us...” page included with this manual for contact 
information.

3. Check for licensing using the GEHC MS service tool. (See chapter 4, Service Tool and Configuration). 
Go to Configuration > Licensing. If license is not activated, install the license(s).

4. Check that the patient monitor is configured to display the parameter. 

Noisy waveforms, missing 
markers or inaccurate 
patient data

Check for ECG configuration filter using the GEHC MS service tool (See chapter 4, Service Tool and 
Configuration) as follows.

1. Go to Configuration > ECG Config Filter.

2. Check that the Patient Data Module power frequency setting matches the patient monitor’s power 
frequency setting.

3. Check that ECG Config Filter is enabled.

If this does not correct the problem, follow steps in the ‘No parameter’ section in this table. 

Patient Data Module will 
not dock

1. Check for damage to mounting rails. If damaged, replace the mounting rails.

2. Check for damage to the docking station (bedside dock, transport dock, or mini-dock). If damaged 
replace the docking station.

GEHC MS service tool 
‘red’ values

If the following values in are highlighted red, they are out of specification. See chapter 4, Service Tool and 
Configuration, Diagnostics > Service Metrics.

Under TEMPERATURE & VOLTAGE RAILS if Main DSP voltage and temperature is red (out of 
specification) replace the Main cpu board. See chapter 7, Field Replaceable Units for ordering parts and 
replacement procedures.
Under TEMPERATURE & VOLTAGE RAILS if ARM and ECG voltage is red (out of specification), 
contact GE technical support to service the Patient Data Module. See the “How to Reach Us...” page 
included with this manual for contact information.

Problem Solution



Troubleshooting

2030047-001A Patient Data Module 6-5

Error messages
The following error messages display at the patient monitor if there is a serious 
problem with the Patient Data Module.

Error message Action

COMMUNICATION 
FAILURE

Go to See Problems and solutions on page 6-3.

BATTERY FAIL Go to See Battery care on page 5-7.

SERVICE THE PDM Contact GE technical support. 
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Ordering Parts
The parts lists in this chapter supply enough detail for you to order replaceable parts.

If you require additional information or troubleshooting assistance, contact GE 
Technical Support.

To order parts, contact Service Parts at the address or telephone number listed on the 
“How to Reach Us...” page included with this manual.

Parts
The table below lists replaceable assemblies that can be ordered.

Item Number Description

2031069-002 Battery door and tray

2031069-003 Battery

2031069-004 Patient Data Module mount rail and pull tab

2031069-005 Label kit Nellcor

2031069-006 Label kit Masimo

2031069-007 NBP assembly with MFLD hose

2031069-008 NBP MFLD hose, coup, elbow only

2031069-009 Top housing

2031069-010 Main cpu (includes software CD)

2031069-011 Expansion cover

2028783-001 Solar to Patient Data Module adapter

2017098-001

2017098-002

2017098-003

2017098-004

2017098-005

ePort to host interface cable, 5 ft.

ePort to host interface cable, 10ft.

ePort to host interface cable, 15 ft.

ePort to host interface cable, 20ft.

ePort to host interface cable, 25 ft.

2021968-001 Fixed mount adapter (Mini dock)

2030340-001 Bedside dock

2030341-001 Transport dock
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Disassembly guidelines

WARNING
REPAIR TO THE FRU LEVEL—Field repairs are recommended to 
the field replaceable unit (FRU) only. Attempting a field repair on a 
pcb or a factory sealed component or assembly could jeopardize the 
safe and effective operation of the Patient Data Module.

NOTE

GE recommends using the new fasteners (screws, washers, etc.) provided in the 
FRU kits rather than re-using the old fasteners. Some fasteners are not intended 
to be re-used more than three times.

Take advantage of existing thread pattern cut by turning the screw 
counterclockwise until it drops into the existing thread pattern.

Tools required
A T10 TORX-style screwdriver and a standard set of hand tools are required for 
disassembly and assembly. Wearing safety glasses is recommended.

Before disassembly
Before disassembling the Patient Data Module, always do the following: 

Remove all cables.
Remove the battery.
Provide appropriate electrostatic discharge protection to prevent damaging the 
Patient Data Module. See Electrostatic discharge (ESD) precautions below for 
details.

Hardware precautions
Observe the following guidelines when disassembling the Patient Data Module:

Note the positions of wires, cables and different sized screws; marking them if 
necessary to ensure they are replaced correctly.
Do not kink, pinch, stretch, twist, or tightly fold a flex cable.

Electrostatic discharge (ESD) precautions
All external connectors of the Patient Data Module are designed with protection from 
ESD damage. However if the module requires service, exposed components and 
assemblies inside are susceptible to ESD damage. This includes human hands, non-
ESD protected work stations or improperly grounded test equipment.
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The following guidelines may not guaranty a 100% static-free workstation, but can 
greatly reduce the potential for failure of any electronic assemblies being serviced:

Discharge any static charge you may have built up before handling 
semiconductors or assemblies containing semiconductors.
A grounded, antistatic wristband (3M part number 2046 or equivalent) or heel 
strap should be worn at all times while handling or repairing assemblies 
containing semiconductors.
Use properly grounded soldering and test equipment.
Use a static-free work surface (3M part number 8210 or equivalent) while 
handling or working on assemblies containing semiconductors.
Do not remove semiconductors or assemblies containing semiconductors from 
antistatic containers (Velo-stat bags) until absolutely necessary.
Make sure power to an assembly is turned off before removing or inserting a 
semiconductor.
Do not slide semiconductors or electrical/electronic assemblies across any 
surface.
Do not touch semiconductor leads unless absolutely necessary.
Semiconductors and electronic assemblies should be stored only in antistatic 
bags or boxes.
Handle all PCB assemblies by their edges.
Do not flex or twist a circuit board.

Replacement procedures
Unless otherwise stated, reassemble the Patient Data Module in reverse order of 
disassembly.

Battery
1. Open the battery door by gently pulling on the battery door pull tab.

862A

2. Pull the battery tray out of the Patient Data Module using the battery tray strap 
and remove the battery.

3. Insert the new battery with the test button facing up and the arrow pointing into 
the Patient Data Module.
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855A

4. Press the battery door closed until it seals the battery compartment.

WARNING
PHYSICAL INJURY—Make sure the battery is completely inserted 
and that the battery door is securely sealed.

Falling batteries could seriously or fatally injure neonatal or other 
vulnerable patients.

5. Press the Power button on the Patient Data Module.

6. Verify that the Power LED illuminates amber while the Patient Data Module 
boots up, then illuminates green.

404B

Power LED
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Labels
Apply labels as shown.

404B

464A

Battery door and tray
1. Remove 1 screw that holds the battery door to the housing and remove the door 

and washer.

462A

2. Remove the battery if one is in the tray.

3. Use a flathead screw driver to lift the catch tab on the tray as you pull it out of the 
housing.

screw
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468A

Mount rail and pull tab
1. Remove 2 screws on the latch stop. Remove the latch stop.

463A

2. Grasp the pull tab between thumb and index finger as shown and gently pull it 
straight out about a half inch. Lift the assembly out of the rail slot.

catch tab

Latch stop 
screws
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469A

NOTE

In the event that the pull tab assembly comes apart when pulled from the rail 
slot, reassemble as shown below.

470A

471A

3. Remove 2 short screws at the rear of the mount rail and 2 long screws at the front 
of the mount rail.

464A

4. Unseat the mount rail by twisting it slightly. Lift mount rail off the top housing.

Long screws
Short screws
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NOTE

When reassembling, make sure there are not gaps between the mount rail 
and the housing when re-seating.

Top housing
1. Remove the mount rail and pull tab per above steps.

2. Remove 4 machine screws that hold the top and bottom housing together.

464A

3. Turn the Patient Data Module right side up and lift off the top housing.

4. Install the top housing as follows:

a. Inspect the gasket in the top housing to be sure it is securely placed in the 
groove.

472A

b. Make sure the flex connector to the front panel board is connected securely.

Gasket
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473A

c. Starting at the rear of the module, position alignment pins of the top housing 
into the bottom housing holes, then close the housing straight down.

474A

d. Squeeze the top and bottom housings together to eliminate gaps. Install the 
screw near the Power ON button first.

Front panel 
connector

Alignment pins
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Main board
1. Remove the top housing per above steps.

2. Disconnect the NIBP cable from the connector without pulling on the wires.

465A

3. Remove 6 screws on the main board.

4. Remove the main board.

NOTE

When installing the main board, position it into the alignment pins, (See 
figures above and below.) fold the flex material over the top of the board and 
hold in place while installing screws.

5. Load new software from the CD included in the Main board FRU kit. Go to 
Software Transfer on page 4-9 for instructions.

6. Calibrate analog out. Go to Calibration on page 4-10 for instructions.

NIBP cableAlignment pins

Alignment pin
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7. Licensing information must be re-entered. Contact GE technical support and 
provide the Patient Data Module serial number and MAC address to proceed. See 
the “How to Reach Us...” page included with this manual for contact information. 
Go to Licensing on page 4-9 for instructions on entering the new activation code.

8. Manufacturer’s serial number must be re-entered. Go to Asset Settings on page 
4-8 for instructions on entering the manufacturer’s serial number.

9. Go to the Solar 8000M/i patient monitor service manual and complete checkout 
procedures.

NBP hose, coupling and elbow
1. Remove the top housing and main board per above steps.

2. Disconnect the front panel connector.

477A

3. Disconnect the main board flex pump connector.

4. Hold flex out of the way and disconnect the NBP hose from the coupling.

5. Remove hose from the manifold.

NOTE

When reassembling, slide hose all the way onto the manifold fitting so that 
the hose lays flat.

6. Go to the Solar 8000M/i patient monitor service manual and complete checkout 
procedures.

Front panel 
connector

Main board flex pump 
connector

NBP hose 
and coupling

NBP hose at 
manifold
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NBP assembly with manifold hose
1. Remove the top housing, main board, NBP hose, coupling and elbow per above 

steps.

2. Remove 4 screws from the battery cover.

467A

3. Grasp and slide the battery cover out to the rear.

4. Remove 1 screw under the pump tube connection.

466A

5. Lift off the manifold with pump.

6. Remove the interface gasket.

Front panel board connector Main board flex pump connector

Battery cover
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478A

7. Before installing the NBP assembly with manifold:

a. Make sure the pump and manifold are fully seated together.

b. Make sure the gasket is in place.

c. Position the manifold and pump in the bottom housing and carefully press to 
seat connector.

d. Install the screw, then connect the hose. Slide hose all the way onto the 
manifold fitting so that the hose lays flat.

e. Make sure the pump is resting between the positioning protrusions.

8. After replacing the NBP assembly with manifold, use the GEHC MS service tool 
to clear all NBP statistics and perform the checkout procedures in the Solar 
8000M/i service manual, Maintenance and checkout chapter. 

Interface gasket
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Technical Specifications

Physical

Environmental

Battery

Height: 7.0 cm (2.75 in)

Width: 14.6 cm (5.75 in)

Depth: 21.6 cm (8.5 in)

Weight: 1.1 kg (2.5 lbs.) without optional battery

1.3 kg (2.8 lbs.) with optional battery

Power requirements

Input voltage:

Input current:

8 to 17 Vdc

0.3A nominal at 16.75 V

Power consumption: 4.5 Watts, nominal

Cooling: Natural convection

Operating heat dissipation: 10.2 Btu/Hr 

NOTE

System may not meet its performance specifications if stored or used outside the 
manufacturer’s specified temperature and humidity ranges.

Operating temperature and 
humidity:

10º C to 35º C (50º F to 95º F)

15% to 95% RH non-condensing

Storage temperature and 
humidity:

 -40º C to 60º C (-40º F to 140º F)

15% to 95% RH non-condensing

Type: Exchangeable lithium ion

Quantity: One

Voltage: 11.1 V nominal

Capacity: 1.8 Amp hour nominal

Run time: Approximately 3.5 hours with new fully charged battery

Charge time: Approximately 2 hours 

Battery life: 500 cycles to 50% capacity



Appendix A–Technical Specifications

2030047-001A Patient Data Module A-3

ECG

Standard leads available: I, II, III, V1 to V6, aVR, aVL, and aVF

Leads analyzed 
simultaneously:

Twelve (I, II, III, V1 to V6, aVR, aVL, and aVF)

Lead fail: Identifies failed electrodes and switches to those intact

Lead fail sensing current: Active electrodes: <30 nA each

Reference electrode: <270 nA

Input specifications

QRS detection range:

Signal width:

Heart rate range:

Common mode rejection:

Gain accuracy:

Linearity deviation:

Noise:

±0.5 mV to ±5 mV

40 ms to 120 ms (Q to S)

30 to 300 beats per minute

90 dB minimum at 60 Hz

±5% (diagnostic mode)

±5%

<30 μV (referred to input)

Output specifications

Frequency response Monitoring mode:

 0.05 to 100 Hz

 0.05 to 40 Hz

 0.05 to 25 Hz

Diagnostic mode:

 0.05 to 150 Hz

Analog output: Selectable at 1V/mV

Defibrillator sync/analog out 
delay

<35 ms 

Sampling rate Monitoring mode: 240 samples/second

Diagnostic mode: 500 samples/second
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Heart rate Heart rate averaging: 8 / 4 beats

Display update interval: 2 seconds

Heart rate accuracy: ± 1% or ± 1 beat/minute, whichever is 
greater

Response time: < 6 seconds

Limit alarm delay: <10 seconds after limit alarm condition 
exceeded

Heart rate alarm range: 0 to 300 beats/minute, high limit > 
low limit

Arrhythmia analysis: 1 to 100 PVCs/minute

Method: QRS morphology classification and timing based on 
single- or multiple-lead analysis

Arrhythmia calls: Full, lethal only, or no arrhythmia

PVC alarm limit range: 1 to 100 PVCs/minute

ST Segment analysis

Measurement description: ST segment deviation is measured and displayed for all 
acquired leads

ST display: Lead label, ST deviation, current complex superimposed 
over a reference complex, J-point indicator and 15-minute 
mini-trends are shown for all acquired leads

Measurement point: Measured at user-selectable measurement points (0, 30, 40, 
50, 60, and 80 ms) following the J point

Measurement range:

Display resolution:

ST measurement 
averaging:

-12.0 mm to + 12.0 mm

0.1 mm

16 beats

ST alarm limits: ± 12 mm, high limit > low limit, for any event within a lead 
group (inferior, lateral or anterior) that exceeds the alarm 
limit for that group

Pace detection/rejection

Input voltage range:

Input pulse width:

Rise time:

Over/under shoot:

Mode:

Standard leads available:

±2 mV to ±700 mV

0.1 ms to 2 ms

10 μs to 100 μs

2 mV (maximum)

Pacemaker artifact rejection ‘On’ or ‘Off’.

I, II, RL, LL
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Respiration

Temperature

Respiration range limit: 1 to 200 breaths/minute

Respiration rate accuracy 0 to 120 breaths/minute ± 1

121 to 200 breaths/minute ± 3

Impedance range: 100 to 1500 Ohms at 52.6 KHz

Detection sensitivity range: 0.4 to 10 Ohms impedance variation

Respiration rate alarm 
range:

1 to 200 breaths/minute

No breath alarm range: 3 to 30 seconds

Number of channels: Up to 2 (with Y-adapter cable)

Input specifications

Probe type: Series 400 or 700 (determined by input cable)

Temperature range: 0° C to 45° C (32° F to 113° F)

Resolution: ±0.01° C (internal)

Output specifications

Parameters displayed: T1, T2 

Error (independent of source):

 ±0.1° C with series 400 probes

 ±0.3° C with series 700 probes

Alarms: User-selectable upper and lower limits
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Invasive blood pressure

Number of channels: Up to 4 (with appropriate cables)

Transducer sites, site name 
and displayed values:

arterial (ART): systolic, diastolic, mean and rate

femoral (FEM): systolic, diastolic, mean and rate

pulmonary artery (PA): systolic, diastolic and mean

central venous pressure (CVP): mean

left atrial (LA): mean

right atrial (RA): mean

intracranial pressure (ICP): mean

umbilical artery (UAC): systolic, diastolic, mean and rate

umbilical vein (UVC): mean

special pressure (SP): mean

Transducer requirements Transducers meeting the following specifications can be 
used, however, have not been evaluated by UL.

NOTE

Note: UL Classification covers the following invasive 
blood pressure transducers:

Utah, Deltran IV CPT-400
Edwards, PX600
Bekton Dikinson, P23XL-1
Abbot, 42582-08

Accuracy: ±2% or ±1 mmHg, whichever is greater (exclusive of 
transducer)

±2% or ±3 mmHg, whichever is greater (exclusive of Patient 
Data Module)

Over pressure rating: 500 kPa (4000 mmHg) above atmospheric pressure (all 
except catheter tip transducers)

Under pressure rating: 50 kPa (400 mmHg) below atmospheric pressure (all except 
catheter tip transducers)

Excitation voltage:

Transducer output:

±2.5 V dc ±0.1%

50 μV/V/cm Hg

Input specifications

Range:

Offset:

-25 mmHg to 349 mmHg

±150 mmHg 
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Non-invasive blood pressure

Output specifications

Frequency response:

Zero balance range:

Zero balance accuracy:

Accuracy:

Displayed frequency 
response:

Display scale selections:

Analog output:

Alarms:

Alarm range:

dc to 40 Hz (+0/-3 dB)

±150 mmHg

±1 mmHg

±2% or ±1 mmHg, which ever is greater (exclusive of 
transducer)

0 to 12 Hz or 0 to 40 Hz (-3dB) user-selectable

0-30, 0-40, 0-60, 0-100, 0-160, 0-200, 0-300 mmHg

1 V/100 mmHg

User selectable upper and lower limits for systolic, diastolic, 
and mean pressures

-99 to 350 mmHg

Measurement technique: Oscillometric

Displayed parameters: Systolic, diastolic, and mean pressures, pulse rate, time of 
last measurement

Measurement modes: Manual, Auto, and Stat

Heart rate detection Adult, pediatric and neonate: 30 to 240 beats per minute

Total cycle time: 20 to 40 seconds typical (dependent on heart rate and motion 
artifact)
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Systolic pressure range

Diastolic pressure range

Mean pressure range

Cuff pressure range

Adult: 30 to 290 mmHg

Pediatric: 30 to 240 mmHg

Neonatal: 30 to 140 mmHg

Adult: 10 to 220 mmHg

Pediatric: 10 to 200 mmHg

Neonatal: 10 to 110 mmHg

Adult: 20 to 260 mmHg

Pediatric: 20 to 215 mmHg

Neonatal: 20 to 125 mmHg

Adult: 0 to 290 mmHg

Pediatric: 0 to 250 mmHg

Neonatal: 0 to 150 mmHg

Pressure accuracy

Automatic cycle times:

Auto zero:

Tubing length:

Automatic cuff deflation:

Static: ±2% or ±3 mmHg, whichever is greater

Clinical: ±5 mmHg average error, 8 mmHg standard deviation

0 to 24 hours 

Zero pressure reference prior to each cuff inflation

Variable

Cycle time exceeding 3 minutes (85 seconds neonatal), 
power off, or cuff pressure exceeds 290 mmHg (± 6 mmHg) 
for adult, 250 mmHg (± 5mmHg) for pediatric, or 150 mmHg 
(± 3mmHg) for neonatal

Cuff sizes

Disposable: Large adult, adult, small adult, pediatric, child, 
and neonatal

Reusable: Adult thigh, large adult, adult, small adult, small 
adult/child, child, and infant

Alarms: User-selectable upper and lower limits for systolic, diastolic, 
and mean pressures



Appendix A–Technical Specifications

2030047-001A Patient Data Module A-9

Pulse oximetry (Sp02)

Parameters monitored: Arterial oxygen saturation (SpO2) and peripheral pulse rate 
(PPR)

Probe types: Masimo (reusable/single use)

Nellcor (reusable/single use)

Masimo range

SpO2: 1 to 100%

Pulse rate: 25 to 240 beats per minute

Masimo accuracy1

1Refer to manufacturer’s specifications for probe accuracy statement.

70 to 100% SpO2: ±2

<69% SpO2: Unspecified

±3 beats per minute without motion

±5 beats per minute with motion

Masimo patents This device is covered under one or more of the following 
U.S.A. patents:

5,758,644, 5,823,950, 6,011,986, 6,157,850, 6,263,222, 
6,501,975 and other applicable patents listed at http://
www.masimo.com/patents.htm

Nellcor range

SpO2: 1 to 100%

Pulse rate: 20 to 250 beats per minute

Nellcor accuracy1

70 to 100% SpO2: Adult ±2, neonatal ±3

<69% SpO2: Unspecified

Pulse rate: ±3 beats per minute without motion

Analog output: Selectable saturation 0 to 100% equivalent 0 to 1V

Alarm limit range: SpO2: 0 to 100%

PPR:  0 to 350 beats per minute.

Messages:

Nellcor:

NO SENSOR, DEFECTIVE SENSOR, SENSOR OFF, 
UNRECOGNIZED SENSOR, LOW PERFUSION, PULSE 
SEARCH, INTERFERENCE DETECTED, AMBIENT LIGHT, 
LOW SIGNAL IQ

PROBE OFF PATIENT, LOW QUALITY, PULSE SEARCH
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Cardiac output

Certifications

Method: Thermodilution

Parameters Displayed: Cardiac output, blood temperature, injectate temperature, 
real-time cardiac output washout curve, last average CO

Cardiac output range: 0.2 to 15 liters per minute

Blood temperature range: 17°C to 42°C (62°F to 107°F)

Blood temperature 
accuracy:

 ±0.5°C 17°C to 30°C

Injectate temperature 
range:

0°C to 30°C (32°F to 86°F)

Injectate temperature 
accuracy:

±0.3°C

Cardiac output review: Accept/reject individual measurements and store average

Catheter sizes: 5, 6, 7, 7.5, or 8 French

Injuectate volume 
selections:

3, 5, or 10

IEC/EN/UL 60601-1

CAN/CSA C22.2 No. 601.1

IEC/EN 60601-1-2

IEC/EN 60601-2-27

IEC/EN 60601-2-30

IEC/EN 60601-2-34

IEC/EN 60601-2-49

IEC/EN 60601-2-51

EN 12470-4

EN ISO 9919

ANSI/AAMI SP10

ANSI/AAMI EC11

ANSI/AAMI EC13

CE Marking: Medical Devices Directive - 93/42/EEC

JJG 760

YY 91079
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Warranty

One year warranty
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Electromagnetic compatibility (EMC)
Changes or modifications to this system not expressly approved by GE can cause 
EMC issues with this or other equipment. This system is designed and tested to 
comply with applicable regulation regarding EMC and must be installed and put into 
service according to the EMC information stated in this appendix.

WARNING
Use of portable phones or other radio frequency (RF) emitting 
equipment near the system may cause unexpected or adverse 
operation.

WARNING
The equipment or system should not be used adjacent to, or stacked 
with, other equipment. If adjacent or stacked use is necessary, the 
equipment or system should be tested to verify normal operation in 
the configuration in which it is being used.

Guidance and manufacturer’s declaration – 
electromagnetic emissions

The Patient Data Module is intended for use in the electromagnetic environment 
specified below. It is the responsibility of the customer or user to assure that the 
Patient Data Module is used in such an environment.

Emissions Test Compliance Electromagnetic Environment – Guidance

RF Emissions

EN 55011

Group 1 The equipment uses RF energy only for its internal function. Therefore, its RF 
emissions are very low and are not likely to cause any interference in nearby 
electronic equipment.

RF Emissions

EN 55011

Class A

Harmonic Emissions

EN 61000-3-2

Class A The equipment is suitable for use in all establishments other than domestic and 
those directly connected to the public low-voltage power supply network that 
supplies buildings used for domestic purposes.

Voltage Fluctuations/

Flicker Emissions

EN 61000-3-3

Complies
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Guidance and manufacturer’s declaration – 
electromagnetic immunity

The Patient Data Module is intended for use in the electromagnetic environment 
specified below. It is the responsibility of the customer or user to assure that the 
Patient Data Module is used in such an environment.

NOTE

Ut is the AC mains voltage prior to application of the test level.

Immunity Test EN 60601 Test Level Compliance Level Electromagnetic Environment – Guidance

Electrostatic 
Discharge (ESD)

EN 61000-4-2

± 6 kV contact

± 8 kV air

± 6 kV contact

± 8 kV air

Floors should be wood, concrete or ceramic tile. If 
floors are covered with synthetic material, the relative 
humidity should be at least 30%.

Electrical Fast 
Transient/Burst

EN 61000-4-4

± 2 kV for power supply lines

± 1 kV for input/output lines

± 2 kV for power supply 
lines

± 1 kV for input/output 
lines

Mains power should be that of a typical commercial 
or hospital environment.

Surge

EN 61000-4-5

± 1 kV differential mode

± 2 kV common mode

± 1 kV differential mode

± 2 kV common mode

Mains power should be that of a typical commercial 
or hospital environment.

Voltage dips, short 
interruptions and 
voltage variations 
on power supply 
input lines

EN 61000-4-11

<5% Ut (>95% dip in Ut) for 0.5 
cycles

<40% Ut (>60% dip in Ut) for 5 
cycles

<70% Ut (>30% dip in Ut) for 
25 cycles

<5% Ut (>95% dip in Ut) for 5 s

<5% Ut (>95% dip in Ut) 
for 0.5 cycles

<40% Ut (>60% dip in 
Ut) for 5 cycles

<70% Ut (>30% dip in 
Ut) for 25 cycles

<5% Ut (>95% dip in Ut) 
for 5 s

Mains power should be that of a typical commercial 
or hospital environment. If the user of the equipment 
requires continued operation during power mains 
interruptions, it is recommended that the equipment 
be powered from an uninterruptible power supply or a 
battery.

Power Frequency 
(50/60 Hz) 
Magnetic Field

EN 61000-4-8

3 A/m 3 A/m Power frequency magnetic fields should be at levels 
characteristic of a typical location in a typical 
commercial or hospital environment.
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Recommended separation distances
The following table provides the recommended separation distances (in meters) 
between portable and mobile RF communications equipment and the Patient Data 
Module.

The Patient Data Module is intended for use in the electromagnetic environment on 
which radiated RF disturbances are controlled. The customer or the user of the Patient 
Data Module can help prevent electromagnetic interference by maintaining a 
minimum distance between portable and mobile RF communications equipment 

Immunity Test EN 60601 Test Level Compliance Level Electromagnetic Environment – Guidance

Portable and mobile RF communications equipment should not 
be used closer to any part of the equipment, including cables, 
than the recommended separation distance calculated from the 
equation applicable to the frequency of the transmitter.

Recommended separation distance

Conducted RF

EN 61000-4-6

Radiated RF

EN 61000-4-3

3 Vrms

150 KHz to 80 MHz

3 V/m

80 MHz to 2.5 GHz

3 V rms

3 V/m d = 1.2

d = 1.2 80 MHz to 800 MHz

d = 2.3 800 MHz to 2.5 GHz

where P is the maximum output power rating of the transmitter in 
watts (W) according to the transmitter manufacturer, and d is the 
recommended separation distance in meters (m).

Field strengths from fixed RF transmitters, as determined by an 
electromagnetic site surveys, should be less than the compliance 
level in each frequency range.

Interference may occur in the vicinity of equipment marked with 
the following symbol:

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by reflection from structures, objects, and 
people.

aField strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radio, AM and FM 
radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed 
RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the equipment is 
used exceeds the applicable RF compliance level above, the equipment should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the equipment.

bOver the frequency range 150 KHz to 80 MHz, field strengths should be less than 3 V/m.
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(transmitters) and the Patient Data Module as recommended below, according to the 
maximum output power of the communications equipment.

For transmitters rated at a maximum output power not listed above, the recommended 
separation distance [d] in meters (m) can be estimated using the equitation applicable 
to the frequency of the transmitter, where P is the maximum output power rating of 
the transmitter in watts (W) according to the transmitter manufacturer.

NOTE

These guidelines may not apply in all instances. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people.

Compliant cables and accessories

WARNING
The use of accessories, transducers and cables other than those 
specified may result in increased emissions or decreased immunity 
performance of the equipment or system.

The table below lists cables, transducers, and other applicable accessories with which 
GE claims EMC compliance.

NOTE

Any supplied accessories that do not affect EMC compliance are not included.

Separation Distance in Meters (m) According to Frequency of Transmitter

Rated Maximum Output 
Power of Transmitter in 

Watts

150 kHz to 80 MHza

d = 1.2

80 MHz to 800 MHz a

d = 1.2

800 MHz to 2.5 GHza

d = 2.3

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

aAt 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

Category Description Maximum Lengths

ECG Cables

Cable, ECG 3/5 lead Multi-Link 6 m / 20 ft

Compatible ECG trunk cable, 5-lead 3 m / 10 ft

Compatible ECG trunk cable, 3-lead 3 m / 10 ft



B-6 Patient Data Module 2030047-001A

Appendix B– Electromagnetic Compatibility

Care cable, ECG 3-lead Multi-Link w/grabber 3.6 m / 12 ft

Care cable, ECG 3/5-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 3-lead Multi-Link din, neonatal 3.6 m / 12 ft

Care cable, ECG 6-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 12-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 12-lead ESU Multi-Link 3.6 m / 12 ft

Care cable, ECG 3/5-lead ESU Multi-Link 3.6 m / 12 ft

ECG Multi-link Leadwires

Lead wire set, 5-lead, Multi-Link-group, grabber 130 cm / 51 in

Lead wire set, 3-lead, Multi-Link-group, grabber 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, grabber 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, grabber V2-V6 130 cm / 51 in

Lead wire set, 3-lead, Multi-Link, MiniGrab Ld I 74 cm / 29 in

Lead wire set, 3-lead, Multi-Link, adult graber Ld II 74 cm / 29 in

Lead wire set, Multi-Link individual grabber 130 cm / 51 in

Lead wire set, Multi-Link individual snap 130 cm / 51 in

Lead wire set, Multi-Link individual grabber V2-V6 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, snap 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link-group, snap 130 cm / 51 in

Lead wire set, 3-lead, Multi-Link-group, snap 130 cm / 51 in

Lead wire set, Multi-Link, neonatal, mini-clip/DIN 60 cm / 24 in

Lead wire set, Multi-Link, banana, limb leads 130 cm / 51 in

Lead wire set, Multi-Link, banana, V-leads, C-leads 130 cm / 51 in

Lead wire set, Multi-Link, radiotranslucent grabber 1.6 m / 60 in

Lead wire set, 6-lead, Multi-Link, snap 130 cm / 51 in

Lead wire set, 6-lead, Multi-Link, grab 130 cm / 51 in

10-lead, banana, AHA, RL-V6 130 cm / 51 in

Invasive BP Cables and Transducers

IP cable Utah 3.6 m / 12 ft

IP cable Spectramed 3.6 m / 12 ft

IP cable Abbott Transpac-III 3.6 m / 12 ft

IP cable, bifurcated, dual BP adapter 30 cm / 12 in

Care IP cable, Utah 3.6 m / 12 ft

Care dual IP cable, Utah 3.6 m / 12 ft

Category Description Maximum Lengths
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Care IP cable, Abbott Transpac-IV 3.6 m / 12 ft

Care dual IP cable, Abbott Transpac-IV 3.6 m / 12 ft

Care IP Edwards Life Sciences Truwave adapter cable 3.6 m / 12 ft

Care dual IP Edwards Life Sciences Truwave adapter 
cable

3.6 m / 12 ft

Care IP Spectramed cable 3.6 m / 12 ft

Care dual IP Spectramed cable 3.6 m / 12 ft

Utah Disposable transducers N/A

Spectramed transducers N/A

Abbott Transpac-III  transducers N/A

Edwards Truwave transducers N/A

Cardiac Output Cables and Probes

Cardiac Output Cable 3.6 m / 12 ft

Cardiac Output Probe 2.4 m / 8 ft

Temperature Cables and Probes

Dual Temp Cable 20 cm / 8 in

Dual Temp Cable 1.2 m / 4 ft

Temp Probe Interconnect cable, 400 series 3.6 m / 12 ft

Care cable, dual temp 400/700 series 0.5 m / 1.6 ft

Care cable, temp 400/700 series 0.5 m / 1.6 ft

Care cable, temp single to disp 400/700 series 3.6 m / 12 ft

SpO2 cables and sensors

Cable Masimo LNC-10 GE connector 3.0 m / 9.8 ft

Patient adapter cable - Nellcor DIGICAL - 3m (one wire 
removed)

3.0 m / 0.8 ft

Care SpO2 patient adapter cable - Masimo 3.6 m / 12 ft

Care SpO2 patient adapter cable - Nellcor DIGICAL 3.6 m / 12 ft

Masimo disposable adhesive sensor, LNOP-ADT, adult N/A

Masimo disposable adhesive sensor, LNOP-PDT, 
pediatric

N/A

Masimo disposable adhesive sensor bridge, LNOP-Neo, 
neonatal

N/A

Masimo disposable adhesive sensor, LNOP-NeoPt-L, 
neonatal

N/A

Masimo reusable multsite sensor, LNOP-YI N/A

Masimo reusable sensor, pediatric N/A

Category Description Maximum Lengths
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Masimo reusable sensor, finger N/A

Masimo sensor LNCS Adtx adult adhesive N/A

Masimo sensor LNCS Pdtx PED adhesive N/A

Masimo sensor LNCS Inf-L infant adhesive N/A

Masimo sensor LNCS Neo-L neonatal adhesive N/A

Masimo sensor LNCS NeoPt-L NEOPT neonatal 
adhesive

N/A

Masimo sensor LNCS DCI adult reusable N/A

Masimo sensor LNCS DCIP ped reusable N/A

Masimo sensor LNCS Y1 multisite reusable N/A

Masimo sensor LNCS TC-I TIP-CLIP ear reusable N/A

Masimo sensor LNCS TF-I reusable forehead N/A

Masimo sensor LNOP DC_195 reusable finger sensor N/A

Masimo sensor LNOP DCSC reusable spot check 
sensor

N/A

Masimo sensor LNOP DC-12 reusable spot check 
sensor

N/A

Masimo sensor LNOPTF-I reusable forehead sensor N/A

Masimo sensor LNOP NEO-L neonate adhesive sensor N/A

Masimo sensor LNOP NEOPT-L sensitive skin neo 
adhesive sensor

N/A

Masimo sensor LNOP INF-L infant adhesive sensor N/A

Masimo sensor LNOP NEO-bridge neonate adhesive 
sensor

N/A

Masimo sensor LNOP NEOPT-sensitive skin bridge 
neonate adhesive sensor

N/A

Masimo sensor LNOPv In disposable infant sensor N/A

Masimo sensor LNOPv Ne disposable neonate sensor N/A

Masimo sensor LNOPv Ad disposable adult sensor N/A

Masimo adult adhesive LNOP sensors N/A

Masimo pediatric adhesive LNOP sensors N/A

Masimo infant/pediatric LNOP HiFi sensor N/A

Masimo neonatal/adult LNOP HiFi sensor N/A

Masimo infant/pediatric LNOP thumb/toe sensor N/A

Nellcor OxiMax MaxFast forehead sensor N/A

Nellcor OxiMax adhesive sensor, adult N/A

Nellcor OxiMax adhesive sensor, adult long N/A

Category Description Maximum Lengths



Appendix B– Electromagnetic Compatibility

2030047-001A Patient Data Module B-9

Nellcor OxiMax adhesive sensor, pediatric N/A

Nellcor OxiMax adhesive sensor, infant N/A

Nellcor OxiMax adhesive sensor, neonatal N/A

Nellcor OxiMax adhesive sensor, nasal N/A

SC-PR N/A

Nellcor SoftCare nonadhesive sensor, neonate N/A

Nellcor SoftCare nonadhesive sensor, adult N/A

Nellcor Durasensor DS-100A finger-clip sensor, reusable 
adult

N/A

Nellcor Oxiband OXI-A/N, adult, neonatal, reusable N/A

Nellcor Oxiband OXI-P/I, pediatric/infant, reusable N/A

Nellcor Dura-Y D-YS, multi-site sensor N/A

Nellcor D-YSE ear clip for Dura_Y sensor N/A

Nellcor PediCheck D-YSPD pediatric spot check sensor N/A

Nellcor OxiCliq adhesive sensor - adult N/A

Nellcor OxiCliq adhesive sensor - neonatal/adult N/A

Nellcor OxiCliq adhesive sensor - infant N/A

Nellcor OxiCliq adhesive sensor - pediatric N/A

Accessories

Cable, defib sync to unterminated end 15’ 4.6 m / 15 ft

Cable, defib sync to Physio-Control 15’ 4.6 m / 15 ft

Cable, defib sync to DataScp 95-31’ 9.5 m / 31 ft

Cable, defib sync to AAMI 6P ECG 4.6 m 4.6 m / 15 ft

Cable, defib sync to HP/Philips 18’ 5.5 m / 18 ft

ePort cable 7.6 m / 25 ft.

Category Description Maximum Lengths
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